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Research-Based Principles
Reading comprehension, the ability to draw meaning from text, is the 
ultimate goal of reading instruction. 

Vocabulary knowledge and background knowledge are closely linked 
and are key contributing factors for reading comprehension (Adams, 
1990; Scarborough, 2001; Recht & Leslie, 1988). The issue of early oral 
language exposure is complex. Although some controversy surrounds 
studies on the issue, the “word gap” describes a disparity between 
exposure to oral language in the early years of life for children from 
language-rich environments as compared with some of their peers 
(Golinkoff et al., 2019; Sperry et al., 2019; Hart & Risley, 1995). This 
disparity creates both a vocabulary gap and a background knowledge 
gap (Snow, 2017). In addition, the quality of young children’s language 
experience matters as much or more than the quantity (Snow, 2017; 
Seidenberg & MacDonald, 2018). 

To build vocabulary and background knowledge in the classroom, 
experts recommend combining content instruction and reading 
instruction (Cabell & Hwang, 2020; Petscher et al., 2020). Content 
knowledge supports the ability to make inferences, a key component 
of reading comprehension (Cabell & Hwang, 2020). 

Research shows that reading aloud coupled with teacher think-
alouds enhances student comprehension by demonstrating how 
skilled readers actively construct meaning from text. Think-alouds 
model essential strategies like predicting upcoming events, clarifying 
confusing sections, and connecting the text to students’ prior 
knowledge (Pearson & Duke, 2004; Pressley & Gaskins, 2008). 

Vocabulary instruction should focus on academic vocabulary and 
“tier 2” words, those words that are commonly seen in narrative and 
informational texts but whose meanings may not be part of students’ 
oral vocabularies (Beck et al., 2002). Words should be selected for 
instruction based on their frequency, utility, and instructional potential 
(Biemiller, 2010; Graves, 2006). Multiple-meaning words and those 



Research-Based Principles    3

that can be used across disciplines in varied contexts should be a 
high priority for explicit instruction (Beck et al., 2002). Words that are 
conceptually challenging or represent ideas critical to a student’s 
grade level should also be targeted (Hiebert, 2019). Morphology 
instruction creates bridges between meaning and spelling (Castles et 
al., 2018) and supports reading comprehension (Kilpatrick, 2015; Kirby 
et al., 2012).

New words should be introduced with student-friendly definitions, 
experienced in multiple contexts, and learned through repeated 
exposures (Beck et al., 2002). Isabelle Beck emphasizes the importance 
of directly teaching word meanings and providing multiple exposures 
to new words through context-rich explanations, engaging questions, 
examples and nonexamples, and opportunities for students to use the 
words in their own speech and writing (Beck et al., 2002). Using clear 
and consistent routines for explicit instruction of words that are critical 
for comprehension and knowledge building has been shown through 
empirical studies to improve comprehension. 

Comprehension strategies, particularly summarizing, questioning, and 
monitoring, are helpful tools when used in the context of a primary 

Tier 3
Domain-specific vocabulary

Tier 2
High-utility vocabulary found in many contexts

Tier 1
Everyday words learned through conversation and known by most students

Tier 2 Focus for Vocabulary Instruction (Based on Beck et al., 2002)
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focus on content. Comprehension strategies instruction should be 
brief, targeted, and applied to a variety of texts (National Reading 
Panel, 2000: Shanahan, et. al.; McKeown, et. al., 2009).

Importantly, all instruction related to comprehension should happen in 
the context of purposeful reading of high-quality, authentic texts. 

Building comprehension in any language builds those skills across 
languages. Comprehension skills are transferable from one language 
to another. Making connections between vocabulary words, meaning, 
and content knowledge across languages builds students’ skills and 
understanding in both languages. 

Comprehension & Vocabulary 
Skills Development

Beginning Developing Advanced

	⦁ Support oral language development through purposeful conversation and 
engaging read-alouds.

	⦁ Build vocabulary and background knowledge.

	⦁ Increase reading fluency so that students can focus on meaning as they read.

	⦁ Foster critical-thinking skills through rich reading experiences with narrative  
and informational texts.

	⦁ Teach comprehension strategies.

Less Complex More Complex
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Waterford Early Learning 
Instruction

  → Comprehension & Vocabulary Skills Taught and 
Scope & Sequence

View example comprehension and vocabulary activities from 
Waterford Early Learning’s adaptive learning path → here.

Students build understanding before, during, and after reading 
Waterford Early Learning books.

Experiences with Waterford Early Learning books foster the growth of 
background knowledge, vocabulary, and critical-thinking skills. Supports 
that help students read with purpose and understanding surround each 
book and are embedded within the texts.

Narrative texts include the following 
Waterford Early Learning series: Sing 
a Rhyme, Read With Me, Traditional 
Tales, and Read-Along Books. 

Students build content knowledge 
through the reading of informational 
texts that cover a wide variety 
of topics.

https://resources.waterford.org/reference-materials/3773/3773.pdf
https://resources.waterford.org/reference-materials/3773/3773.pdf
https://www.youtube.com/playlist?list=PLcOxVO3wRlRSaC2-5hRcjCUEJWB7aJOJE
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Before Reading 

Activate Background 
Knowledge

Build Background 
Knowledge Make Connections

Before reading The 
Little Monkey, students 
sort statements that 
describe a monkey, an 
elephant, or both.

Before reading The 
Little Red Hen, students 
learn about how bread 
is made.

Before reading The 
Talking Lizard, students 
think about animals 
that are seen in their 
own surroundings.

During Reading 

Inspector Detector Embedded Vocabulary 
Support

In many Waterford Early Learning books, Inspector 
Detector provides a think-aloud model, guiding 
students to pause and think during reading. Prompts 
are centered on making predictions, considering 
the author’s choice of language, thinking about 
the characters, and more. These experiences help 
students monitor their comprehension and make 
any necessary repairs to their understanding.

Students can select 
bolded words to 
see and hear the 
word’s pronunciation 
and definition.
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After Reading 

Describe Characters Compare Texts Extend Understanding

After reading Anansi 
and the Seven Yam 
Hills, students describe 
the characters.

After reading The Ugly 
Duckling, students 
compare the text to 
other stories.

After reading What 
is a Cloud?, students 
answer questions about 
the topic.

Comprehension strategies are introduced and applied to 
increasingly complex texts through a variety of digital activities 
including the following:

	⦁ Peek at the Story

	⦁ Make Connections

	⦁ Step into the Story

	⦁ Check My Prediction

	⦁ Ask a Question

	⦁ Find an Answer

	⦁ Sum-Up, Remember Order

	⦁ Sum-Up—Five Ws

To see examples of these activities, search for the activity title in 
→ Resources & Activities.

https://teacher.waterford.org/activities
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Students receive explicit vocabulary instruction for words drawn from 
Waterford Early Learning’s authentic, high-quality texts. Instruction is 
focused on high-utility “tier 2” and academic vocabulary.

Prior to reading the 
text, word meanings 
are introduced with 
student-friendly 
definitions. 

Understanding of 
word meanings is 
reinforced through 
practice activities with 
scaffolded feedback.

After encountering the 
words in connected 
text, students check 
their understanding.

Additional vocabulary instruction focuses on synonyms, affixes, word 
categories, and more.

As students work through Waterford Early Learning’s adaptive learning 
path, they acquire new vocabulary through explicit instruction and 
wide reading of narrative and informational texts. When students 
learn the meanings of new words, they also learn about the larger 
ideas and concepts connected to those words. A broad vocabulary 
bank fosters a broad knowledge bank, both of which support strong 
reading comprehension.
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Resources
Resources to support comprehension 
and vocabulary skills development in 
the classroom and at home include 
the following:

Comprehension
  → In Resources & Activities,

	⦁ FILTER for Resource Type>WEL Activity and Subject & 
Strand>Literacy>Comprehension & Vocabulary.

  → In Resources & Activities,

	⦁ Go to Collections>Graphic Organizers.

  → My Comprehension Checklist

  → Reading With Understanding

  → Group Reading Activities

  → Stories and Poetry

  → Compare and Contrast

  → Find the Similarity Between Two Texts

  → Graphic Organizers

  → Story Map

  → Five Finger Retell

  → Story Board 1

  → Story Board 2

  → Sequence Ladder

  → Sequence Organizer

  → Summarize a Story

A Waterford account is required 
to access program hyperlinks 
(displayed in orange). If you do 
not have an account, you can 
request a demo account here.

https://teacher.waterford.org/activities
https://teacher.waterford.org/activities?query=resourceType%3DWEL%2520Activity%26subject%3DLiteracy%257CComprehension%2520%2526%2520Vocabulary
https://teacher.waterford.org/activities?query=resourceType%3DWEL%2520Activity%26subject%3DLiteracy%257CComprehension%2520%2526%2520Vocabulary
https://teacher.waterford.org/activities
https://teacher.waterford.org/activities?query=collections%3DGraphic%2520Organizers
https://resources.waterford.org/practice-materials/2702/2702.pdf
https://resources.waterford.org/teacher-resources/2708/2708.pdf
https://resources.waterford.org/teacher-resources/1722/1722.pdf
https://resources.waterford.org/teacher-resources/2709/2709.pdf
https://resources.waterford.org/teacher-resources/852/852.pdf
https://resources.waterford.org/teacher-resources/1721/1721.pdf
https://resources.waterford.org/practice-materials/3527/3527.pdf
https://resources.waterford.org/practice-materials/2700/2700.pdf
https://resources.waterford.org/practice-materials/3530/3530.pdf
https://resources.waterford.org/practice-materials/3529/3529.pdf
https://resources.waterford.org/practice-materials/3533/3533.pdf
https://resources.waterford.org/practice-materials/3534/3534.pdf
https://resources.waterford.org/practice-materials/3545/3545.pdf
https://www.waterford.org/reading-academy/#request-demo
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Vocabulary/Background Knowledge
  → In Resources & Activities,

	⦁ FILTER for Resource Type>WEL Activity and Subject & 
Strand>Literacy>Comprehension & Vocabulary.

	⦁ FILTER for Resource Type>WEL Activity and Subject & 
Strand>Literacy>Comprehension & Vocabulary, and SEARCH 
for “build knowledge.”

  → Context Clues (word meanings)

  → Defining Words

  → Identify New Meanings for Words

  → Graphic Organizers

  → K-W-L Chart

  → T-Chart

  → Venn Diagram (circles)

  → Venn Diagram (squares)

Narrative Books
  → In Resources & Activities, go to

	⦁ Collections>Books: Read-Along.

	⦁ Collections>Books: Traditional Tales.

	⦁ Collections>Books: Chapter Books.

Informational Books
  → In Resources & Activities, go to

	⦁ Collections>Books: Biographies.

	⦁ Collections>Books: Informational Texts.

https://teacher.waterford.org/activities
https://teacher.waterford.org/activities?query=resourceType%3DWEL%2520Activity%26subject%3DLiteracy%257CComprehension%2520%2526%2520Vocabulary
https://teacher.waterford.org/activities?query=resourceType%3DWEL%2520Activity%26subject%3DLiteracy%257CComprehension%2520%2526%2520Vocabulary
https://teacher.waterford.org/activities?query=subject%3DLiteracy%257CComprehension%2520%2526%2520Vocabulary%26resourceType%3DWEL%2520Activity&search=build%20knowledge
https://teacher.waterford.org/activities
https://teacher.waterford.org/activities?query=collections%3DBooks%253A%2520Read-Along
https://teacher.waterford.org/activities?query=collections%3DBooks%253A%2520Traditional%2520Tales
https://teacher.waterford.org/activities?query=collections%3DBooks%253A%2520Chapter%2520Books
https://teacher.waterford.org/activities
https://teacher.waterford.org/activities?query=collections%3DBooks%253A%2520Biographies
https://teacher.waterford.org/activities?query=collections%3DBooks%253A%2520Informational%2520Texts
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Playlists
  → In Resources & Activities,

	⦁ FILTER for View>All Playlists and Subject & 
Strand>Literacy>Comprehension & Vocabulary. 

Family Resources
  → Family Fact Sheet: Comprehension & Vocabulary
  → Hoja de datos familiars—Vocabulario y Comprensión

  → Family Video: Comprehension & Vocabulary
  → Video de elemento de instrucción de vocabulario y 

comprensión

  → Reading Together Bookmark
  → Marcador de leyendo juntos

  → Sum Up: Remember Order
  → Resumir: Recordar el orden

  → Sequence Game
  → Juegos de secuencia

  → In Resources & Activities,

	⦁ FILTER for Resource Type>Books (PreK-2) to find hundreds of 
Waterford Early Learning books in English and Spanish.

	⦁ go to Collections>Reading Together Activities (Families). 

https://teacher.waterford.org/activities
https://teacher.waterford.org/activities/playlists?query=subject%3DLiteracy%257CComprehension%2520%2526%2520Vocabulary
https://teacher.waterford.org/activities/playlists?query=subject%3DLiteracy%257CComprehension%2520%2526%2520Vocabulary
https://resources.waterford.org/family-resources/4741/4741.pdf
https://resources.waterford.org/family-resources/4742/4742.pdf
https://resources.waterford.org/videos/1017/1017.mp4
https://resources.waterford.org/videos/1965/1965.mp4
https://resources.waterford.org/videos/1965/1965.mp4
https://resources.waterford.org/family-resources/3978/3978.pdf
https://resources.waterford.org/family-resources/4852/4852.pdf
https://resources.waterford.org/family-resources/1187/1187.pdf
https://resources.waterford.org/family-resources/1188/1188.pdf
https://resources.waterford.org/class-activities/5126/5126.pdf
https://resources.waterford.org/class-activities/5127/5127.pdf
https://teacher.waterford.org/activities
https://teacher.waterford.org/activities?query=resourceType%3DBooks%2520(PreK-2)
https://teacher.waterford.org/activities?query=collections%3DReading%2520Together%2520Activities%2520(Families)
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Instructional Routines
The following instructional routines can serve as frameworks for 
whole-class, small-group, and individual instruction. These routines 
leverage the elements of effective instruction that are built into the 
adaptive learning path for Waterford Early Learning.

Read-Alouds
Use this instructional routine for small-group or whole-group dialogic 
read-aloud experiences.

Before Reading

1.	 Provide explicit instruction for vocabulary words that will support 
comprehension of the book, using the vocabulary instructional 
routine outlined below. 

2.	Build students’ background knowledge as needed. A → K-W-L Chart 
can be used as a framework for understanding what students 
already know. 

3.	Make connections with students’ prior knowledge and experiences. 
For example, ask, “Have you ever eaten porridge? Have you heard 
other stories about bears?” 

4.	Display the cover of the book. As you point to the 
relevant information, say, “The title of this book 
Goldilocks and the Three Bears. The author is 
Madge Tovey and the illustrator is Suzanne Smith.”

5.	Set a purpose for reading. For example, say, “Let’s 
read this book to find out about what happens 
when Goldilocks visits the bears’ house.”

During Reading 

1.	 Model fluent reading (i.e., reading at an appropriate rate with 
accuracy and expression). For example, change your voice for each 
character. Demonstrate how punctuation, such as exclamation 
points, give information about meaning and affect how you read 
the text.

https://resources.waterford.org/practice-materials/3536/3536.pdf
https://resources.waterford.org/books-prek-2-/1255/1255.pdf
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2.	Make the experience interactive by engaging students in active 
participation. For example, have students mimic the gestures and 
expressions of characters. A prompt could be: “Move your arms and 
change your face to look like Papa Bear.”

3.	Stop to make, check, and revise predictions. Here is an example:

	⦁ What do you think Goldilocks will do with 
the porridge/chairs/beds?

	⦁ What will the bears notice when they see 
the porridge/chairs/beds?

	⦁ For each prediction, stop at the appropriate moments to 
confirm whether they were accurate or think about how you 
might revise your predictions as the story unfolds.

4.	Point out vocabulary words as they are encountered in the text. 
Clarify word meanings through discussion as needed. Refer to 
images or concrete objects used in instruction. If a gesture was 
taught, ask students to act it out.

5.	Model comprehension monitoring through a think-aloud approach. 
For example, model how to think about word meanings to support 
understanding. Say, “What words does the author use to describe 
how the bears talk? Papa Bear growled. I know that a growl is a 
sound that dogs make when they are mad or angry. I think that 
means that Papa Bear is mad.”

After Reading

1.	 Guide students to complete the → K-W-L Chart to indicate what 
they learned.

2.	Reinforce understanding by engaging students in practice with a 
comprehension strategy. For example, use the → Summarize a Story 
resource to guide a group discussion.

3.	Compare and contrast with other texts. For example, say, “The 
characters in Goldilocks and The Three Little Pigs both have 
a problem.

https://resources.waterford.org/practice-materials/3536/3536.pdf
https://resources.waterford.org/practice-materials/3545/3545.pdf
https://resources.waterford.org/books-prek-2-/1255/1255.pdf
https://resources.waterford.org/books-prek-2-/1262/1262.pdf
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	⦁ How are the problems in the two stories similar? How are 
they different?

	⦁ How do the characters in each story solve their problems?

	⦁ What are some other similarities between the two stories?

	⦁ What are some other differences between the two stories?

	⦁ What other stories do you know that include similar problems?” 

4.	Build depth of understanding through → extension activities.

5.	Share resources with families for reading time at home. 

	⦁ PDF book: English / Spanish

	⦁ Narrated book: English / Spanish

	⦁ Reading Together Activities: English / Spanish

Vocabulary
Use this instructional routine to introduce new word meanings.

Carefully select words for instruction. Choose  
high-utility, tier 2, academic vocabulary words that 
are drawn from texts students will read and that 
connect to classroom learning goals and/or content 
area studies.

For example, if students are learning about the three 
states of matter, provide vocabulary instruction 
for the words solid, liquid, and gas before reading 
Pancakes Matter.

Before Reading

1.	 Set the purpose. For example, say, “Before we read Pancakes 
Matter, we will learn about some words you will see in the book. 
Understanding these words will help you understand the book.”

2.	Introduce the words with student-friendly definitions and 
explanations. For example, “A solid, like ice, is something that is 
hard and keeps the same shape no matter where you put it. When 

https://resources.waterford.org/teacher-resources/4900/4900.pdf
https://resources.waterford.org/family-resources/4901/4901.pdf
https://resources.waterford.org/family-resources/4902/4902.pdf
https://resources.waterford.org/books-prek-2-/2243/2243.pdf
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it is warmer, ice turns to a liquid. A liquid is something that can be 
poured, and it takes the shape of the container you put it in. When 
water is a lot warmer, it turns to a gas. A gas, like the steam you see 
rising from a pot of boiling water, can move and change shape and 
is often hard to see.”

3.	Use visuals, gestures, and/or concrete objects to reinforce meaning. 
The images in → this resource illustrate the words solid, liquid, and 
gas. Use the images to engage students in a discussion about 
examples and nonexamples. For example, show each image as 
you ask students, “Is this a solid?” Students respond yes or no. Ask 
students to brainstorm more examples and nonexamples.

4.	Guide students to use the words in sentences.

During Reading

1.	 Point out the vocabulary words in context. Clarify word meanings 
through discussion as needed.

2.	Refer to images or concrete objects used in instruction. If a gesture 
was taught, ask students to act it out.

After Reading

1.	 Provide multiple encounters with the words. For example, engage 
students with Water, where they will encounter the words solid, 
liquid, and gas.

2.	Create structured opportunities for students to use the words in 
writing and conversation.

3.	Build depth of understanding through → extension activities.

4.	Share the English or Spanish (Los panqueques cuentan, Agua) 
versions of the books with families for additional practice at home.

https://resources.waterford.org/practice-materials/4153/4153.pdf
https://resources.waterford.org/books-prek-2-/2393/2393.pdf
https://resources.waterford.org/family-resources/2801/2801.pdf
https://resources.waterford.org/books-prek-2-/2346/2346.pdf
https://resources.waterford.org/books-prek-2-/3002/3002.pdf
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Corrective Feedback
Corrective feedback has been shown to be a particularly powerful 
form of feedback (Hattie & Jaeger, 1998). It has a substantial effect 
size, meaning it can significantly improve learning outcomes. Within 
Waterford Early Learning’s adaptive learning path, corrective feedback 
helps students build new understandings through productive struggle. 

As you engage students in the instructional routines outlined above, 
provide corrective feedback that

	⦁ is immediate and timely;

	⦁ is targeted and specific;

	⦁ is asset-based and encouraging;

	⦁ provides additional information, as applicable (e.g., using a 
video to provide more background knowledge);

	⦁ approaches the task in a new way, as applicable (e.g., 
using a graphic organizer or role-playing the meanings of 
vocabulary words);

	⦁ is shared through multiple modalities (e.g., visual and 
auditory); and

	⦁ does not simply provide the correct answer, but instead guides 
students to confirm or self-correct their thinking to arrive at the 
correct answer.
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